Networking TaxWise for AARP Tax-Aide
Updated September 2011

Introduction:

For the desktop version of TaxWise, only wired networks are permitted. For TaxWise Online and
for printing only, wireless networks may be used. This document describes how to set up a wired
network using two or more computers and a printer.

Why use networking?

Security:
e Only one computer contains taxpayer data.

Convenience:
e Only one computer needs TaxWise updates.
e Only one computer needs to be backed up.
e All connected computers have access to all returns.
e Printer sharing is easy — no printer switch boxes are required.
e Counselor computers can be used at multiple sites

e Counselor computers do not have to have TrueCrypt or other encryption
software

When should networking be used?

Any time a site uses two or more computers, up to a maximum of 10
computers with Windows XP Professional, and up to 20 with Windows 7
Professional.

How does one network computers?
The following pages show how to set up for networking.

There is a wealth of information in both Windows Help and on the Internet on how
to set up peer-to-peer networks. Windows also provides “Wizards” to help set up a
network.

WIRELESS NETWORKING TO SHARE A PRINTER IS ALLOWED.

However SUPPORT is NOT AVAILABLE from CCH or the IRS.
See the PRINTING Document on the AARP Tax-Aide ExtraNet

A network can have two or more computers. Generally there is one printer, but there can be two or
more. Two computers should be connected using a Crossover Ethernet Cable. More than two
should be connected to a network router or a network switch using Standard Ethernet Cables.

The most powerful computer is generally chosen for the TaxWise server if full networking is to be
done. Use a computer with a professional version of the Windows operating system versus a
home version. The home versions do not have the networking capability of the professional

AARP Foundation Tax-Aide Page 1 of 30
National Technology Committee taxaidetech@aarp.org



Networking TaxWise for AARP Tax-Aide
Updated September 2011

versions and support fewer workstations. Complete all Windows Updates before doing the
network setup.

Almost all the steps that need to be taken are in the computer setup. Be sure that the network is
working before you attempt to configure or use TaxWise. The TaxWise program can be already
installed on the computers, or not. Every computer connected in a network can be used for doing
tax returns.

A network can be split into two or more sections if physical space is such that too many cables

need to be run. Multiple network switches can be connected using multiple Ethernet cables.
Computers are connected to the switches as needed based on physical layout.

Part 1 of these instructions applies to all computers.

Part 2 has instructions for connecting computers and configuring them just to share a printer.
Part 3 has instructions for full networking of TaxWise.

Appendix A includes equipment information together with some possible sources.

Appendix B provides a network checklist and troubleshooting information.

Appendix C has Microsoft Security Essentials (MSE) antivirus and malware protection data

Appendix D contains FAQs, Frequently Asked Issues and Answers
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PART 1 - FOR ALL COMPUTERS
1. Windows Accounts

For the instructions that follow, it is essential that all computers connected on a LAN
have the same Windows Logon account and password!

(If you have a good understanding of Windows Security and Networking then different
accounts can be used.) For TaxWise installation and operation the accounts must belong to the
Administrators Group. Most IRS and AARP computers come set with accounts in the
administrators group; however, if in doubt, check.

Windows Accounts
XP Vista/Win 7

Start > Settings > Control Panel > Start>Control Panel>User Accounts
User Accounts. Each account will
show which group it belongs to

Windows accounts can be created if needed on either the AARP-owned computers or IRS
Depot supplied computers but should NEVER be changed! Adding an account is done in
Windows Control Panel — User Accounts. See Windows Help if you don’t know how to add an
account.

IT IS MANDATORY THAT ALL WINDOWS ACCOUNTS USED IN AARP TAX-
AIDE HAVE A PASSWORD.

2. Computer Name and Workgroup Name

All computers on a network must have a unigue name, and belong to the same
workgroup.

IRS Depot-supplied laptops will have a unique name, but it’s not easy to remember — change
it! Using the IRS Barcode Number is a good name choice, but anything can be used. Windows
will tell you if you use an invalid character in the computer name.

The workgroup should be set to VOLGROUP. If it isn’t then change it to VOLGROUP (it is
more secure than using the default Windows names). The workgroup listed on IRS Depot
computers may also need to be changed to VOLGROUP this year.
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To change computer name and/or workgroup

XP Vista/Win 7
Right click on “My Computer” on the Right Click "Computer" on the
Windows Desktop. Click on Windows Desktop. Click on
Properties. Click on the “Computer Properties. On the bottom right click
Name” tab. on "Change Settings".

There is no need to enter anything in Computer description. Click on Change. Type the Computer
name. Recommendation is that you use the Asset Tag Number (Barcode Number) for the
computer. Prefix with a “T” if it is an AARP computer with an all-numeric asset number. Any
name will do provided it is unique on the network. Make sure that the “Member of” section has
Workgroup selected. Tab to the Workgroup field and enter VOLGROUP then click OK.

It is not necessary to restart the computer at this point, since it will be restarted at the end of this
Part | of the instructions.

3. Disk Write Caching

(Not doing this step will not affect the ability to network the computers— this is a precautionary
step to minimize possible problems later)

(This step cannot be done on the AARP HP nx6310 laptops which use a different hard drive
interface. “Turning off write caching " is disabled on these computers).

Windows, by default, writes data to a disk through a disk cache (a temporary storage area in
memory) to speed up overall disk access time. Under some circumstances due to a momentary
failure of the network or a power source this can be a problem with networking and file
sharing and could cause corruption of the TaxWise database.

To turn off Disk Write Caching

XP Vista/Win 7
Double click on “My Computer”; right Double click on “Computer”; right click
click on Drive C:\ and select Properties. on Drive C:\ and select Properties.

Click on the Hardware tab. Select the hard | Click on the Hardware tab. Select the hard
drive so it is highlighted blue and click drive so it is highlighted blue and click

Properties. Click on the Policies tab. Properties. Click on "Change settings™ at
Uncheck “Enable write caching on this the bottom of the page; Click the Policies
disk”. Click OK twice then close My tab. Uncheck “Enable write caching on
Compulter. this disk”. Click OK twice then close My
Computer
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4. Windows Firewall

The Windows Firewall Service must be turned ON. Since AVG was replaced with Microsoft
Security Essentials (MSE) as an Antivirus and malware program, the use of the Windows
Firewall is required.

For all Windows Operating Systems: In the Control Panel double click on Windows
Firewall. Make sure that the Windows Firewall status is ON.

5. Microsoft Security Essentials

AVG has been replaced with Microsoft Security Essentials (MSE) as an Antivirus and
Malware protection program. MSE does not have a built-in firewall as AVG did and therefore
does not require special settings for networking. The use of an Antivirus program is mandatory
to protect against virus and threats from the Internet and from tainted data from external media
such as CD, DVD and flash drives.

6. Firewalls and IRS Depot Laptops

IRS Depot supplied computers do not have firewall software installed except for the built-in
features of Windows XP. As previously noted, the Windows firewall must be turned ON.

7. Network Connections
(Some parts of this may need to be done on IRS Depot Computers.)

Network Connections

XP
In the Control Panel double click on

Vista/Win 7
In control Panel click on “Network and

“Network Connections”. Right click on
“Local Area Connection” and select
Properties. Be sure you are on the General
Tab.

In the section “This connection uses the
following items” make sure that every item

is checked. You may have to scroll down
to see them all.

Click once on “Internet Protocol
(TCP/IP)” and click on Properties.

Make sure you are on the General Tab and
check both “Obtain an IP address
automatically,” and “Obtain DNS server
address automatically.” Click OK.

While still in Local Area

Sharing Center." Click on "Change
adapter settings™ in upper left and then
right click on "Local Area Network" and
select Properties. Be sure you are on the
Networking Tab.

In the section “This connection uses the
following items” make sure that every
item is checked. You may have to scroll
down to see them all.

Click once on “Internet Protocol Version
4 (TCP/IPv4)” and click on Properties.
Make sure you are on the General Tab
and check both “Obtain an IP address
automatically,” and “Obtain DNS server
address automatically.” Click OK.
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Connection Properties, make sure
that “Show icon in notification area
when connected” is checked, and
“Notify me when this connection
has limited or no connectivity” is
NOT CHECKED. Then click OK.
Select Back to return to the Control
Panel.

a. Folder Options

Folder Options

XP

Vista/Win7

In Control Panel Double click on Folder
Options and select the “View” Tab.
Make sure that “Automatically search for
network folders and printers” IS NOT
checked. (We know what we want; we

In Control Panel click on Folder Options
and select the “View” Tab. Make sure
that “Hide extensions for known file
types” IS NOT checked and "Use
Sharing Wizard" is not checked.

don’t want windows to search for it).
Also make sure that “Hide extensions for
known file types” IS NOT checked, and
that “Use simple file sharing
(Recommended)” IS NOT checked.
Note: Using Simple File Sharing does
present a security risk — it is primarily
provided for “home” networking and is
the standard feature of Windows XP
Home. In Windows XP Home, Simple File
Sharing is not changeable. However a
computer running Windows XP Home
should not be used as a server. Itis
acceptable for a workstation where file
sharing is not required.

Click OK.

b. Power Options

This setting will not stop networking; however we don’t want the server computer to go into
“standby” or “hibernate.” This might happen if the server itself has no activity for a long time. It
can also happen if running on batteries.
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Power Options

XP Vista/Win 7
In Control Panel double click on In Control Panel click on Power
Power Options. Under the “Hibernate” Options and then select radio button
tab UNCHECK the box for “Enable for "Power Saver"; Click on "Change
hibernation” and click Apply. plan settings"”. Under the "On battery"
Move to the “Power Schemes” tab. category, all settings from top to
Set the Power scheme to Always On bottom should be 20 minutes, 30
and click Apply. minutes, 45 minutes. Under the
Move to the Advanced tab. Make sure "Plugged in" settings from top to
that “Prompt for password when bottom all settings should be "Never".
computer resumes from standby” IS Then click on "Change advanced
checked. power settings" in lower left of screen.
Move to the Alarms Tab. The settings In middle window, click plus+ sign by
when the computer was originally Sleep and for Sleep After and change
configured were for the Low battery "plugged in" number to "NEVER" by
alarm to trigger at 45% and to display clicking on down arrow.
a text warning. No other action. The Move down to "Hibernate After" and
Crl_tlcal batteroy alarm was set to change "plugged in" number to
activate at 20% and the computer to "NEVER" by clicking on the down
Hibernate. arrow.

VERY IMPORTANT: It is NOT recommended to run a computer in a network on battery
power. It may happen by “accident” and the existing warning should suffice. However — the
Alarm settings and action can be changed if desired.

After all changes above Click Apply, then click OK.

Restart the computer and log on to the Windows account you will use.
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PART 2 - CONNECTING THE COMPUTERS AND SHARING A PRINTER

1. Connect the Computers

If you are using just two computers; connect them using a Crossover Ethernet cable.

If you are using more than two computers connect each of them to a router (preferred) or
network switch with standard Ethernet cables. Make sure the power supply for the network
router or switch is plugged in.

NOTE: For convenience during the setup process everything can be done using just a
crossover cable — one computer at a time — provided the “server computer” is always
connected.

Most modern network routers and switches will show a single light or a pair of lights for each
successful connection. Close to the Ethernet port on the computer a small, generally green,
light should turn on. The light just means that the network cards and the switch are
communicating. It does not mean that the network is actually complete.

2. Network-connected Printers

Some printers are “network ready” in that they can be connected using a network cable. For
those familiar with networking, this connection can be used. However we recommend the
printer connection be either USB or Parallel. If you are using a network-connected printer, set
the printer you will use for TaxWise as the Windows default printer on all computers on your
network. Then skip ahead to Part 3 on setting up a network.

3. Decide which computer will be the Print Server

The computer with the printer directly connected to it using either a parallel printer cable or a
USB printer cable will be the Print Server. It can be the same computer as the TaxWise server
or a different computer.

There are both pros and cons of having the Print Server be the same computer as the TaxWise
Server. If they are the same, only one server computer has to be up and running to provide all
of the services needed by a client workstation. But if the print server or printer becomes
confused and cannot be sorted out without restarting Windows for the Print Server, that restart
is much more disruptive to an ongoing taxpayer session if the computer being restarted is also
the TaxWise server. Either way will work. We recommend careful consideration of these
trade-offs before making that decision.

If the printer driver needs to be installed on the Print Server computer do it now, following the
manufacturers instructions, and physically connect the printer. The computer will recognize it.
When done, print a test page, just to be sure.

The printer installation process will give the printer a generic name based on the printer model.
It is better to give the printer a unique name so it is easy to recognize. If you have a network
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that has two HP 1022n printers installed, it will be MUCH easier if they each have a unique
name rather than both being called “HP LaserJet 1022n” or whatever the default name is.
Names should be short and simple. For example LASER1, INKJET3, PRINT2, or something
similar.

4. To rename the printer

To name the printer
XP Vista/Win 7

Start, move to Settings, then Printers Start, Device and Printers, Highlight
and Faxes; Highlight the printer and the printer and right click on the name.
right click on the name. Click on Click on "Printer Properties” and type
Rename and type the new name. the new name into the top line under
Press the tab or enter key to finish the General Tab. Press the enter key to
name change finish the name change.

Put a label on the printer showing its name (Please don 't write the name on the printer case
with a marker pen, it’s almost impossible to get off without damaging the plastic).

5. Share the printer to the network

Share the printer to the network

XP

Vista/Win 7

Right click on the printer name you
want to share and select “Sharing.” In
the window that opens check “Share
this printer.” The printer name will
show automatically to whatever it was
named in step 2. To set as the
Windows default printer, right click
printer name>select "Set as Default
Printer". Close Printers and Faxes.

Right Click on the printer name you
want to share and select "Printer
Properties"”. Select the Sharing Tab
click the "Change Sharing Options”
button. Then put a check in the box by
"Share this printer” and printer name
will show automatically to whatever it
was named in step 2. Click Apply and
OK. To set as the Windows default
printer, right click printer name>select
"Set as Default Printer”. Close Device
and Printers
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6. Set all the other computers on the network to access the shared printer.

Before setting up the printer on all other computers, check to make sure that the Firewall
status is ON for each computer.

Access the shared printer

XP Vista/Win 7
Click Start, move to Settings, then Click Start, then “Devices and
“Printers and Faxes.” Click on Printers”. Click on “Add a printer.”
“Printers and Faxes.” Double click on Click on “Add a Network, wireless or
“Add Printer.” The Add Printer Bluetooth Printer.” Select the correct
Wizard will start (it’s OK to use this printer if it shows on the list; if it does
Wizard). Click Next. Select “A not, the click "The Printer that |
network printer, or a printer attached wanted isn't listed”. Click Next.
to another computer”. Click Next. Click the button “Select a shared
“Browse for a printer” will be printer by name” and enter the
selected. Click Next. \\computername\printername then
You should see the network click Next.

information, VOLGROUP, and under
VOLGROUP the name of the Print
Server Computer. Under that should
be the name of the shared printer that
you want to add. If a line of
information has a tiny + sign double
click on it to expand the information.
You may need to wait a short while
for the two computers to find each
other and the printer. If you cannot
see the printer, double check the
Firewall setting. Once you see the
name of the printer highlight it and
click Next

If you cannot find the printer on the network, try shutting down and restarting the computers.
Always start the server first.

Windows will give a warning about printer drivers and viruses; just confirm that you want to
go ahead. Then click “Finish.”

It is a good idea to print a test page from each computer. On each computer, right click on the
printer, select properties, and “Print test page.”

Set the printer you will use for TaxWise as the Windows default printer on all computers on
your network.

More printer setup information can be found in a document called “Printer Installation for
TaxWise”, found on the Extranet at www.aarp.org.tavolunteers.
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IF YOU JUST WANT TO USE ANETWORK TO SHARE A PRINTER,
THEN STOP HERE.
Install TaxWise as a stand-alone program on each computer, if it is not
already installed. Set the printer in TaxWise Setup Options to be the network
printer.

PART 3 -SETTING UP TAXWISE ON THE NETWORK

Decide which computer will be the TaxWise Server. Generally this will be the most powerful
computer; however, local circumstances may dictate otherwise. The more computers linked in the
network then the more power is required from the TaxWise server. Any computer can be used as
the server. However, for use in a Windows XP network. it should have at least 512 MB of RAM, a
processor speed of 1.0 GHz or more, and a fast hard drive. When using Windows Vista or
Windows 7, at least 1GB or more of memory is required.

1. Share the TaxWise Server Disk Drive

a) If the server computer is an IRS Depot Laptop not using TrueCrypt:
In Windows Explorer locate Drive C: and right click on it.
Select Sharing and Security
You will see a Default Share that has been set by Windows as C$. This is for system
purposes, and cannot be deleted.
Click on “New Share”
Enter a Share name of TaxWiseServer_P (recommended, but it can be any valid share name
that is used by the workstations— just keep it short and meaningful).
Click on “Permissions” and check Allow Full Control for the “Everyone” user group. Click
Apply and then OK.
Then select the Security Tab, select Everyone in the Group or user box, now select Full
Control in the Permissions box. Click on OK to close the “Share” Window and return to
Windows Explorer.

b) If the server computer is using TrueCrypt for encryption:
Be sure that the latest TrueCrypt Installer is used to create an encrypted drive/container with
whatever procedure you have elected to use (Local or Traveler Mode).
Click the Start Tax-Aide Drive Icon. The shared drive should have a hand under the drive
icon or before the listing if Detail view is used. You may have to Refresh the Windows
Explorer view to get the hand to appear. If you did not use the latest TrueCrypt Installer (Ver.
7.0a) to create an encrypted drive/container, it is recommended that you set the Security
Permissions to everyone as describe above. Earlier TrueCrypt versions do set the Sharing
permissions, but not the Security permissions.

2. Map a Client (workstation) to the Server Drive.

On any one of the other computers right click on My Computer or Computer, and then click on
Map Network Drive. A drive letter will be suggested by Windows — P is the letter that we
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recommend that you use. Don’t enter anything in Folder. Check Reconnect at Logon, and
then click on Browse. In the “Browse for a folder” window, click on the + signs to expand the
entries. You will see VOLGROUP and the names of the computers connected.

(If you don’t see any other computers, double-click on My Computer and make sure there are
no leftover mapped drives from last year; if so right click on them and then choose
Disconnect.)

Click on the + sign alongside the name of the server computer. You will see the Server shared
drive TaxWiseServer_P. Click the + sign by TaxWiseServer_P. Click on TaxWiseServer P
and it will highlight blue. Click OK. Then click Finish. A connection to TaxWiseServer_ P
will be created. Drive letter P: on the workstation is now “mapped” to the Server drive. Close
the window.

Repeat the above for all the connected computers — except the server.

Configure TaxWise on the Server.
(Note — if installing from a clone CD the procedure here might differ — however if a
workstation number is not already assigned TaxWise will ask for one)

If TaxWise is not installed on the Server then install it now, just as usual from a TaxWise
CD - except — when TaxWise asks “Is this a Network Installation” click Yes. TaxWise will
require a Workstation Number. Enter 101 and click next. Installation will complete, but don’t
run TaxWise yet — restart the computer.

When the computer has restarted, start TaxWise. Go through the Setup process as usual
except check the box “Save as Workstation Defaults.” Also, on the General Tab, check
“Network — My computer is a single or multi-user machine ATTACHED to others.” On the
Printer Setup Tab, select the Network Printer. Register TaxWise with your EFIN and
Registration Code. TaxWise on the Server can be closed, or left running.

If TaxWise is already installed on the Server, start TaxWise and log on as the Admin user.
Go to Tools, then Utilities/Setup Options, and run through the Setup screens. On the General
Tab, check “Network™ and also check the box “Save as workstation defaults.” On the Printer
Tab, choose the network printer in all three boxes. If it is a local printer, you will just see the
printer name. If it is a printer connected to another computer, you will see the printer name
prefixed with the name of the computer it is attached to. Go to the last page and click the
“Finish” button. Close TaxWise. Restart TrueCrypt on the server computer.

Create the required Workstation number for TaxWise. Right click on My Computer, and
click on Properties. Click on the Advanced Tab, and then on Environment Variables. In the
lower of the two Windows, scroll down and see if there is an entry for Workstation. If there
is, then make sure it is 101. If there is no workstation entry, click on “New” just below the
lower window. For “Variable name” enter Workstation, and for “Variable value” enter 101.
Click OK three times, then restart the computer.
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3. Set up and Configure TaxWise on the Client computers. (Do this only after the server
computer is up and running and TrueCrypt is started.)

a) If TaxWise is already installed on any of the Client computers, CCH recommends that it be
uninstalled. At least, remove its icon from the desktop.

It is possible to have TaxWise installed and run stand-alone on each of the client
computers when that computer is not connected to a network. However when running on a
network it is then possible that a volunteer might start the “wrong” version. It is a local
decision as to whether to leave TaxWise installed on a network client computer.

b) On any of the other computers double click on My Computer/Computer. You will see the
Network Drive (for example TaxWiseServer_P (P:). (If you see the network connection as
disconnected, then the server computer is either not running or has not started TrueCrypt as
a server.) Double click on it. Move to the UTSyy Folder and double click. Move to the
TWTECH folder and double click. Locate the SETUP.EXE program and double click on
it. TaxWise workstation setup will start. You will be asked for a Workstation Number —
Enter 102 for the first non-server computer; increment this number by one (1) for each
successive computer installed on the same network (103,104, etc.).

c) For Windows Vista or Windows 7 workstations, you should use the TaxWise CD to

install TaxWise on the workstation, rather than the setup.exe program in the TWTech
Folder on the server.

d) If you want to network TaxWise 2007 or 2008 on a workstation that has Internet
Explorer 7.0, you must set a ‘Local intranet’ permission to avoid a system error that will
prevent accessing TaxWise from the client workstation.

1)
2)
3)
4)
5)
6)
7)

8)
9)

Open Internet Explorer on the workstation and select Tools > Internet Options.
Click on the Security tab.

Click on Local intranet, then click the Sites button.

UNCHECK the Automatically detect intranet network box.

Click the Advanced button.

Type P: and click Add

If you get an error at this point, instead of P: use two slashes followed by the
computer name of the SERVER (e.g. \\servercomputername)

Click Close and OK.

Try to open TaxWise again.

When the setup process is finished, restart the computer. Once restarted there will be a desktop

icon for TaxWise — TaxWise 20yy on P Drive. Double click on it and TaxWise will start.
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APPENDIX A - Equipment

Network Switch and/or Wireless Router (wireless for printing only with a desktop TaxWise
network):

8-Port Switch — Fast Ethernet (100Mbps).
Be sure the wireless router you select to use has a built-in 4-Port switch.

Many sources, prices vary every day! Check:
http://www.pricegrabber.com/search attrib.php/page id=17

Local sales (Office Depot, OfficeMax) can sometime get good prices.
You should not need to pay much more than $25 for a switch, $40 for a router

TrendNet and Zonet tend to be the lower cost makes. LinkSys and DLink are typically
more expensive.

Refurbished items can often be bought with savings. Check out
http://www.tigerdirect.com/applications/Refurb/refurb tlc.asp

Belkin has good wireless routers generally with a lifetime warranty.

Network adapters:
PCMCIA network adapters are readily available for laptops that do not have built-in
Ethernet ports. Buy the ones that have an RJ45 connector, not one that has a “dongle”.
Shop around — Same sources as for network switches.

Network Cables:
Category 5e Ethernet. Not usually worth making your own. Mail Order is usually lowest

cost. Places like Office Depot etc. are generally expensive. One good source is:
http://store.pchcables.com/

In the Midwest, Computer Network Accessories in Ohio is a good source for both cables
and network switches. http://www.cnaweb.com

Prices are very competitive, and shipment costs are reasonable.
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APPENDIX B — Network Checklist and Troubleshooting

Summary: This document provides an abbreviated checklist for Tax-Aide site network setups. It
also provides troubleshooting steps in case there are problems with the network during or after
setup. It is intended to augment more detailed documents that exist on the Extranet.

If the network appears not to work be patient for a while. Even with all the settings correct it can
take a while for Windows Master Browser to “display” the network. If you make a change to any
settings there may be a delay in seeing them take effect. Modern computers are fast, but not
instantaneous!!!

] [ ]

Network Setup Checklist

Hard-wired connections: Connect ALL computers to the network switch/router via
Ethernet patch cables (limit is 9 computers to the server). The cables must be connected to
the LAN receptacles, NOT the WAN/WLAN connector (for routers, only) — that is
reserved for the connection to the Internet.

All connections: Connect the router WAN/WLAN port to the host’s Internet receptacle, if
appropriate.

Plug in all equipment and turn on all network switches/routers.

Wireless connections: If using an Internet Access Computer (IAC), connect the wireless
access point to the IAC and turn on the access point and the IAC.

Wait for the router, access point, and IAC, as appropriate, to stabilize. Then turn on ALL
computers and
CONFIRM:

____ ALL computers are using VOLGROUP as the Workgroup name and the
computer name has been changed from "ChangeMe" to a unique name
(Asset Tag will always be unique and is preferred for AARP purchase
computers)?

____ ALL computers on the network have the same Windows username and
password? [NOTE: a NEW username must be created if
necessary...CHANGING a username WILL NOT WORK!!!]

____File and Printer Sharing is ENABLED
EXCEPTION: TWO computers connected directly to a public Wi-Fi
system must have File and Printer Sharing DISABLED

____The TWD server computer has TrueCrypt TY2011 installed with a share name
of TaxwiseServer_P?

____You have mapped a drive from each TWD client computer to the TaxWise
server computer/share name? Caution: You must share the DRIVE on the
server computer that contains TWD. Just sharing the UTSOX folder WILL
NOT work — you must share the P: drive or C: drive, etc., wherever TWD is
installed.
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____You spelled the computer name and share name correctly?

[]  Hard-wired connections: Confirm that you see a link light on both ends (computer and
router).

[] Wireless connections: Verify the wireless connection is operational (check the icon in the
system tray at the lower right-hand side of the window — it should show “connected”).

[] TaxWise Desktop (TWD): If you set up an Internet connection, verify you can connect to a
Web site, e.g., Www.irs.gov.

[] TWD server: Start the TWD server computer and log in. Verify that each TW client can
login to the server.

[1 Taxwise Online (TWO): Verify that each computer can connect to twonline.taxwise.com.

Troubleshooting The Computer Setup

Can’t map a network drive:

e |If Browse does not find the computer or share name, manually enter
\\computername\sharename in the Folder line of the Map Network Drive window.

e (o to a command prompt, and ping the device you are trying to connect to
(Windows XP, click Start->Run-> enter “cmd”, and press “Enter;” Windows 7,
click Start, enter “cmd,” press Enter). Then type “ping” followed by the IP address
of the device you are trying to connect to. If you get:

o “Reply from” followed by the device IP address, then the physical layer is
working properly.

o “Timed Out,” then there was no reply from the host — but, the host does
exist.

o “Reply from [the IP address of your computer] Destination host
unreachable,” the device that you are trying to ping is down or is not
operating on the network...

o “Unknown host,” then the IP address or the host name does not exist in the
network

e On the server, right click on the P Drive and select Sharing and Security; click the
Permissions Button and set the permissions to “Full Control for Everyone.”

¢ If you made any changes to the router or server, disconnect the mapped drive and
re-map each client.

o If you still cannot map a drive, from the server, right-click on the P Drive and
select Sharing and Security. Then click on the Security Tab; click on Everyone in
the Top window and be sure Full Control is checked in the bottom window.
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Getting “Access Denied” errors when connecting to the network:

e Give the computers a few minutes to set themselves up on the network. It can take
from a few seconds to several minutes for the computers to establish their network
connections.

e Go to a Command Prompt and issue the command: ipconfig /all
o If using a router, all computers should show an IP address starting with
192.168.
o If using a switch/crossover cable, computers should show 169.254...
o Ifit shows “Media disconnected” you have a cabling/card problem or the
wireless card is not connected to a wireless network

o If you get an IP address other than 192.168 or 169.254, then you are
connected to the host’s system. This is fine, but all computers MUST have
the same first 2 octets, i.e., be on the same network — so, if one computer is
on 12.142...., then all computers must show 12.142... — workgroups cannot
span networks.

e On the server, right click on the P Drive and select Sharing and Security; click the
Permissions Button and set the permissions to “Full Control for Everyone.”

¢ If you made any changes to the router or server, disconnect the mapped drive and
re-map each client.

e Unplug the router for 10 seconds and plug it back in.

e Run the Network Setup Wizard on all computers, again. Restart the computers.

Other Possibilities:

e Don’t use Windows 7 Homegroup — use Work network, instead. See the next
paragraph for procedures to change that and the File and Printer Sharing
encryption.

e If using a mix of Windows 7 and XP computers - the Windows 7 computer uses
128 bit encryption for File and Printer Sharing which is not compatible with XP
encryption. To change the Windows 7 computer, do the following.

o Click “Start” and enter “network™ in the search box

o Click “Network and Sharing Center” from the search results

o Click “Change advanced sharing settings” along the left side of the window

o Click the down-arrow to the right of “Home or Work”

o Under “File sharing connections,” change to “Enable file sharing for
devices that use 40- or 56-bit encryption

Under “Home group connections,” choose “Use user account and

passwords to connect to other computers”

o Click “Save changes” and back out of all screens

O
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e Use a utility program to see if there are several other wireless networks in the
vicinity that are on the same channel. inSSIDer is a free program that can show
nearby wireless networks and their strength and channel.

If your devices will still not connect to the network, email TaxaideTech@aarp.org OR call 202-
434-6099 for emergency assistance.
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APPENDIX C - Antivirus Malware Protection

NOTE: Uninstall other antivirus programs before installing Microsoft Security
Essentials AND complete all Windows Updates before installing MSE

Microsoft Security Essentials (MSE)
http://www.microsoft.com/security_essentials/

All AARP Tax-Aide volunteers are required to use an Antivirus program to
protect taxpayer information.

The AARP Tax-Aide strongly encourages all volunteers to download and install
the Microsoft Security Essentials (MSE) antivirus and Malware protection
software.

Microsoft Security Essentials provides real-time protection for your computer
which guards against viruses, spyware, and other malicious software
(MALWARE).

Microsoft Security Essentials is a free* download from Microsoft at and is simple
to install, easy to use, and always kept up to date so you can be assured your PC is
protected by the latest technology. It’s easy to tell if your PC is secure — when
you’re green, you’'re good. It’s that simple.

* NOTE: Your PC must run genuine Windows to install Microsoft Security
Essentials. See the "Validation™" below for license information

Microsoft Security Essentials runs quietly and efficiently in the background so
that you are free to use your Windows-based PC the way you want—without
interruptions or long computer wait times.

Minimum system requirements for Microsoft Security Essentials

Operating System: Genuine Windows XP (Service Pack 2 or Service Pack 3);
Windows Vista (Gold, Service Pack 1, or Service Pack 2); Windows 7

e For XP, a 500 MHz CPU or higher, and 256 MB RAM or higher.

e For Vista and Win7, a 1.0 Ghz CPU or higher, and 1 GB RAM or higher.
« VGA display of 800 x 600 or higher.

» 140 MB of available hard disk space.

« An Internet connection is required for installation and to download the
latest virus and spyware definitions for Microsoft Security Essentials.
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« Internet Browser:
o Windows Internet Explorer 6.0 or later.
o Mozilla Firefox 2.0 or later.

« Microsoft Security Essentials also supports Windows XP Mode in
Windows 7. For more information, see the system requirements for
Windows XP Mode in Windows 7

It is critical to make sure that your computer is running software that protects
against malicious software (or malware). Malicious software that includes viruses,
spyware, or other potentially unwanted software can try to install itself on your
computer any time you connect to the Internet. It can also infect your computer
when you install a program using a CD, DVD, or other removable media.
Malicious software can also be programmed to run at unexpected times, not just
when it is installed.

Did we mention that MSE can be downloaded from the Internet for FREE! Copy
and paste the following link into your browser address line:
http://www.microsoft.com/security_essentials/

All volunteers should download and install MSE as soon as possible.
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Microsoft Security Essentials security status:
MSE has a clean, simple home page that shows the security state of your
compulter.

] ¢ Settings

| Microsoft Security Essentials 15 monitonng your Scan options;
J | computer and helping to protect it.
| ® Quick
—_—

Full

) Custom.,,

@' Reasl-time protection: On ~
@ Virus & spyware definitions:  Up to date lE

A green icon means that the security status of your computer is good. Microsoft
Security Essentials is up -to- date and is running in the background to help protect
your computer against malware and other malicious threats.
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When your computer has an issue that requires your attention, the look of the
Microsoft Security Essentials home page changes based on the issue. The status
pane turns either yellow or red depending on the situation, and an action button
appears in a prominent location on the page with the suggested action.

| Real-time protection is turned off. You should tum it
on,

0 Real-time protection: Off
‘s Virus & spyware definitions:  Connection failed

% Turn on

Nest scan: Sunday around 2:00 AM (Quick scan) | Change my scan schedule

A yellow icon means that status is fair or potentially unprotected and that you
should take some action, such as turning on real-time protection, running a system
scan, or addressing a medium-severity or low-severity threat.
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el

‘lli Rt Security Esserfials
Computer status - At risk

Microzoft Security Essentials detected 1 potential

Scan options:
threat on your computer.

© Quick
() Full

Custom...

© Real-ime protection: On

& Vuus & spyware definitions:  Up to date S(i" Row

Scheduled scan settings
Next scar: Sunday around 2:00 AM (Quick scan) | Change my scan schedule

A red icon means that your computer is at risk and that you must address a severe
threat to protect it. Click the button to take the recommended action and Microsoft
Security Essentials will clean the detected file and then do a quick scan for
additional malicious software.

Licensing: IAW the licensing agreement with Microsoft, use of the Microsoft
Security Essentials software is contingent upon having a validated Windows
operating system installed. Paragraph 2 of the Licensing Agreement is provided
as follows:

2. VALIDATION.

a) The software may cause the operating system software to conduct
validation checks of your operating system software from time to time,
depending upon your specific operating system.

b) Validation verifies that your computer’s operating system has been
activated and is properly licensed. Validation also permits you to use
certain features of the operating system software or to obtain additional
benefits.
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c) If avalidation check is performed, the operating system software will send
information about the software and your operating system software to
Microsoft. This information includes the versions of the software and
operating system software. Microsoft does not use the information to
identify or contact you. By using the software, you consent to the
transmission of this information. For more information, see
http://go.microsoft.com/fwlink/?Linkld=163954.

d) |If, after a validation check, your operating system software is found not to
be properly licensed, the software you are installing may be disabled, or
the functionality of the operating system software may be affected,
depending upon your specific operating system and applicable laws. For
example, you may need to reactivate the operating system software or you
may receive reminders to obtain a properly licensed copy of the operating
system software, or you may not be able to use or continue to use some of
the features of the operating system software or obtain certain updates,
upgrades or services from Microsoft.

e) You may only obtain updates or upgrades for the operating system
software from Microsoft or authorized sources. For more information on
obtaining updates from authorized sources, see
http://go.microsoft.com/fwlink/?Linkld=163955.
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APPENDIX D - Frequently Asked Questions

Frequent Networking Issues and Recommended Solutions

Issue 1: I cannot get the IRS computer to work as a server.

Recommended Solution: Do not use the IRS computers as servers. They work
better as clients, but have additional layers of security that makes it very difficult
to setup as a server. Primary issue seems to be Windows user accounts that are
setup on the IRS laptops. "Changing" the accounts to mirror the server does not
work since attributes are retained. A NEW account should be created that mirrors
the server and all will be well.

Issue 2: | set up server share according to Tax-Aide Networking Instructions
and it does not work.

Recommended Solution: Review each step and be sure you followed ALL
steps.

Issue 3: 1 used these same computers to network last year and this year it
does not work.

Recommended Solution: Be sure to disconnect ALL mapped network drives
and remove ALL shares from previous years and setup new network settings for
the current year. Everything changes and there are no shortcuts to networking.

Issue 4: Windows User Account problems prevent connections to my server.

Recommended Solution: On AARP computers, there should be a standard
Windows login username called "volunteer" and a standard password for the
current Tax Year. User Accounts should not be changed, but created from scratch
(not copied and changed). This is because attributes remain with a copied or
changed account. A “volunteer” account can be added to other laptops as
well...be sure you are logged-in as an Administrator to add a user account

Issue 5: My workstations can see the TaxWiseServer_P share, but | cannot
get into the UTSXX directory to do the setup. | get an access violation.

Recommended Solution: The logged on Windows Accounts must match
exactly on both the server and the workstation. This means that both systems
must have exactly the same accounts and the accounts must have exactly the same
passwords. If there are missing ones, please add them when logged on as Admin.
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Then it does not matter which one you are logged on as; the access will be
available.

If you do not have the User account created on the server that exactly matches the
one on the workstation client, you sometimes cannot even expand the
Txxxxxxxxxx in the VOLGROUP to see the server shares. Once the logged on
Users match exactly then everything works.

Issue 6: | have Different Windows User IDs and Passwords between Clients
and Servers.

Recommended Solution: Use an identical Windows user account with the same
user id and password on the server and all clients.

Alternative Solution: (From Pat Heid 2/02/2008)

| have found that you can network computers which are set up with

different users and different passwords. | have successfully networked

the AARP laptops and IRS laptops without adding users and passwords. |

just got back from helping Harlingen set up a network with an IRS laptop

as the server with three library-furnished computers with no passwords at

all. When mapping the network, the client computer will probably find the
server computer but since the server is password-protected differently from the
client, access will not be granted.

At that point:

1. Right click on the server computer name and select "EXPLORE" from the
menu furnished.

2. A box will appear allowing you to type in the user and password for
the server. Be SURE to check the box "remember my password™ so you
don't have to do this in the future.

3. It will open the shared drive on the server showing the shared drive
(TaxWiseServer_P) with all the folders on that drive.

4. Click the drive to highlight (shows blue).

5. Then close the windows until you are back to "browse" for the server.
This time when you browse the server will show the shared drive and you
can click on it.

6. Click "finish". Your network is established and the drive will open
S0 you can open the TWO08 folder, TWTech folder, and run "setup.exe™ to set
up the workstation on the client.

Issue 7: When mapping the network drive on a client, and clicking the
server name, it does not open the contents of the server.

Recommended Solution: Just wait a while, as this can take a minute or two. If
it still will not open, try enabling the ‘Use simple file sharing’ on the ‘View’ tab
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of ‘Folder Options’ in the Control Panel of the server. Then after the mapping is
completed the “Simple file sharing’ can be disabled.

Issue 8: When trying to connect to a TaxWise server, I get a “Storage Too
Low” warning message.

Not enough server storage is available to process this command.

-and-
Not enough memory to complete transaction. Close some applications and
retry.

Clients cannot access network shares.

Recommended Solutions: Look at
http://support.microsoft.com/default.aspx?scid=kb;en-us;177078

BUT the decimal value that | had to use was 50. 1 tried 15 and 30 with no
success. 50 Works!

RESOLUTION

Warning Serious problems might occur if you modify the registry incorrectly by
using Registry Editor or by using another method. These problems might require
that you reinstall your operating system. Microsoft cannot guarantee that these
problems can be solved. Modify the registry at your own risk. To resolve this
behavior, increase the IRPStackSize value in the registry.

The NTC has created a program to make this change. It avoids having to make
the change yourself in the registry. This program is called “Set IRP Value.txt”
and is available on the Technology page of the AARP Tax-Aide Extranet. To run
the program, change the file extension from “.txt” to “.vbs”.

Issue 9: When my server is set up and shared for networking and | try to
map the network drive from the client to the server’s shared folder or launch
TaxWise from the server, | get an error message like ""Access Violation' or
"Access Denied" or *'System Error."
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Recommended Solution:

Workstations get " System error” followed by access violations when trying §
to access a network installation of TaxWise

My workstations get a "System error” followed by access violations when trying to access a
network installation of TaxWise.

SEiaad LIt —lats 23U

il

Open Internet Explorer and select Tools > Internet Options

Click on the Security tab.

Click on Local intranet, then click the Sites button

Click the Advanced button

Type Z: (substitute Z with the drive letter TaxWise is on) and click Add

If you get an error at this point, instead of Z: use two slashes followed by the computer name
of the SERVER (e.g. \servercomputername)

7. Click Close and OK.

8. Try to open TaxWise again.

After step 3, UNCHECK the Automatically detect intranet network box.
If you still get the same error, please call TaxWise Technical Support.
This should only be an issue with Internet Explorer 7.

O WN

Issue 10: After TaxWise is installed on a client computer, an attempt to open
TaxWise results in an error “Database error” or “Database cannot be read.”

Recommended Solution: On each workstation that gets the error message:

-

. Open UTSYY and run dbrepair.exe. This should fix part of the problem.

2. Go to Control Panel, Region & Language options/customize. Make sure
the short date format is MM/DD/YYYY (it wasn’t on 2 of my computers).

3. Still in Control Panel, open Internet Options/security/local

Intranet/sites/advanced. Add “//server” to zone (see previous Issue for how

to do it).

Issue 11: When | "Open existing returns' in TaxWise 2009 the list is empty.

Recommended Solution: (TaxWise Knowledge Base Answer I1D: 2932)
1. Open the Control Panel
Double-click Administrative Tools
Double-click Microsoft .Net Framework 1.1 Wizards
Choose Trust an Assembly
Make sure the option "Make changes to this computer™ is selected
Click Next
Click on the Browse button
Go to your UTSO09 directory
9. Locate UniversalTaxSystems. TaxWise.Interop.dll and highlight

Nk~ WN
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10.  Click Open

11. Click Next
12.  Move the slider bar to Full Trust
13. Click Next

14.  Click Finish
15.  Repeat steps 4-14, selectingUniversalTaxSystems.Diagnostics. Tax.dll
instep 9
16.  Using Windows Explorer, check the UTS09\USERS\[username]
directories for any file containing 0 KB and delete them.
If this does not correct the problem, contact technical support.

Issue 12: Some client workstations will not open TaxWise. Mapping and
workstation setup ran fine, but there were three errors listed when clicking on the
TaxWise desktop icon on the Vista Home Basic client. Error message said
TaxWise is closing due to--- two database related errors and “1.1 is not valid
floating point value...). The next two clients, both AARP HP notebooks, had
the same problem when trying to open TaxWise. But the error message only
listed the “floating point value’ problem.

Recommended Solution: Tech at CCH found an old knowledge base article that
said corrupted ‘Tax Form Defaults’ files typically cause ‘floating point value’
errors. | was directed to remove two files from TaxWise on the server. (The ‘Tax
Form Defaults’ file (8000000.000) from the ‘UTSOON\USERS\ADMIN\’ folder in
TaxWise and the ‘homepage.htm’ file in the ‘UTS0N\TWHomepage\’ folder.) Then
I individually connected each of the three clients that had the problem and when
the TaxWise icon was clicked it opened the TaxWise program on the server. |
may have rerun the workstation setup on one of the clients, but | know it was not
needed on all three. After the clients properly worked I copied the same ‘Tax
Form Default file’ back into TaxWise and everything still worked. There were
absolutely no set-up changes made on either the server or the clients to resolve the
problem, other than removing the two files, and no changes were made to the Tax
Form Defaults file before placing it back into the UTS09\USERS\ADMIN\ folder.

Issue 13: Access Denied Message when trying to launch TaxWise from the
server’s shared network drive on a client.

Recommended Solution: Access Denied is a permissions problem, so try the
following:

On the TaxWise server computer:

1. Open "My Computer"
2. Right click the P Drive
3. Click on the Sharing and Security Tab
4. Click on the "Permissions” button and make sure “"Everyone" has
FULL CONTROL and click OK
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Click on the Security Tab

Highlight "Everyone™ in the top window by clicking once

7. Make sure the FULL CONTROL box in bottom window is
checked and click OK

8. Then try to open TaxWise again from the workstation client.

oo
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